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THE WIRELESS TELECOMMUNICATIONS BUREAU ANNOUNCES THAT APPLICATIONS
FOR VHF PUBLIC COAST SERVICE LICENSES ARE ACCEPTED FOR FILING

Auction No. 39

Pleading Cycle Established

The long-form applications (FCC Form 601) for the VHF Public Coast (VPC) Service licenses listed in
Attachment A are, upon initial review, accepted for filing.1  It should be noted, however, that the
Commission may return or dismiss any application if it is found, upon further examination, to be
defective or not in conformance with the Commission’s Rules.2

Petitions to deny the applications listed in Attachment A must be filed no later than August 16, 2001,
which is ten days after the date of this Public Notice.3  Oppositions to a petition to deny must be filed no
later than five days after the date on which the petition to deny is filed.4  Replies to the opposition must be
filed no later than five days after the date on which the opposition is filed.5  All filings concerning these
long-form applications should refer to Auction No. 39, as well as any specific file numbers of the
individual applications.

An original and four copies of all pleadings must be filed with Magalie Roman Salas, Office of the
Secretary, Federal Communications Commission, 445 Twelfth Street, S.W., Room TW-A325,
Washington, D.C. 20054, in accordance with Section 1.51(c) of the Commission’s Rules.6  In addition,
one copy of each pleading must be delivered to each of the following locations: (1) the Commission’s
duplicating contractor, International Transcription Service, Inc. (ITS), 1231 Twentieth Street, N.W.,

                                                     
1 This Public Notice addresses only VPC applications.  Location and Monitoring Service applications filed with
respect to Auction No. 39 will be addressed separately.

2 47 C.F.R. §§ 1.746, 1.934.

3 47 C.F.R. § 1.2108(b).

4 47 C.F.R. § 1.2108(c).

5 Id.

6 47 C.F.R. § 1.51(c).
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Washington, D.C. 20036; (2) Keith Fickner, Policy and Rules Branch, Public Safety and Private Wireless
Division, Wireless Telecommunications Bureau, 445 Twelfth Street, S.W., Room 4-C423, Washington,
D.C. 20554; and (3) Mary Shultz, Licensing and Technical Analysis Branch, Public Safety and Private
Wireless Division, Wireless Telecommunications Bureau, 1270 Fairfield Road, Gettysburg, PA 17325.

The applications listed in Attachment A are available to the public for electronic viewing.  Instructions for
obtaining and using the Commission’s Universal Licensing System (ULS) are contained in Attachments
C and D of this Public Notice.  All applications listed in Attachment A will be available to the public
during regular business hours in the Public Safety and Private Wireless Division, Wireless
Telecommunications Bureau, 445 Twelfth Street, S.W., Washington, D.C. 20554.  In addition, copies of
these applications may be obtained from ITS, 1231 Twentieth Street, N.W., Washington, D.C. 20036,
(202) 857-3800.

After completion of the pleading cycle, the Wireless Telecommunications Bureau will release a public
notice listing the licenses that the Commission is prepared to award.  All winning bidders will be required
to pay the balance of their winning bids in a lump sum payment within ten business days following the
release of that public notice.7  Licenses will be awarded upon the full and timely payment of the winning
bids and any applicable late fees.

Please note the following:

•  For technical assistance in using ULS for applications, contact the FCC Technical Support Hotline at
(202) 414-1250.  The FCC Technical Support Hotline generally will be available Monday through
Friday, from 9 a.m. to 6 p.m. ET.  All calls to the FCC Technical Support Hotline are recorded.

•  Those persons seeking answers to legal questions should call Keith Fickner at (202) 418-7308.

This Document Contains the Following Attachments:

Attachment A: Applications Accepted for Filing

Attachment B: Instructions for Searching for Applications Listed in Attachment A

Attachment C: Accessing the FCC Network Using Windows 95/98

                                                     
7 47 C.F.R. § 1.2109(a).
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Attachment A

Applications Accepted for Filing

1) File Number 2) Applicant 3) Market Designator 4) Market Name 5) Seeking a Tribal Lands
    Bidding Credit

0000500292 MacIntyre, Scott C VPC016 Western Oklahoma, OK Yes
0000500292 MacIntyre, Scott C VPC023 Santa Fe, NM Yes
0000500292 MacIntyre, Scott C VPC038 Farmington, NM-CO Yes
0000505639 Maritel, Inc. VPC010 Grand Forks, ND-MN No
0000505639 Maritel, Inc. VPC012 Bismarck, ND-MT-SD No
0000505639 Maritel, Inc. VPC015 North Platte, NE-CO No
0000505639 Maritel, Inc. VPC019 Odessa-Midland, TX No
0000505639 Maritel, Inc. VPC020 Hobbs, NM-TX No
0000505639 Maritel, Inc. VPC021 Lubbock, TX No
0000505639 Maritel, Inc. VPC022 Amarillo, TX-NM No
0000506566 SMR Systems, Inc. VPC013 Aberdeen, SD Yes
0000506566 SMR Systems, Inc. VPC014 Rapid City, SD-MT-NE-ND Yes
0000506598 SMR Systems, Inc. VPC018 San Angelo, TX No
0000506882 Telesaurus Holdings GB, LLC VPC011 Minot, ND Yes
0000506882 Telesaurus Holdings GB, LLC VPC040 El Paso, TX-NM Yes
0000537185 Telesaurus Holdings GB, LLC VPC026 Scottsbluff, NE-WY No
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Attachment B

Search Instructions for Applications Filed for Auction No. 39

This attachment provides instructions for electronically searching the FCC Network for a specific
application or applications on file with the Commission. The following instructions relate specifically to
searching for applications filed in response to Auction 39.

To search the FCC Network for an application, you must first reach ULS through the Internet
(http://www.fcc.gov/wtb/uls ) or through a direct dial-up connection.  (Attachment C describes how
Windows 95/98 users can connect to the FCC Network using the Dial-Up Networking features of
Windows 95/98.)

We recommend that you use Netscape Communicator 4.51, 4.61, or 4.7x (Internet web browser software)
to use ULS for application searches. To download the latest version of Netscape Communicator free of
charge, access the Netscape download site at http://home.netscape.com/download/archive.html

Conventions

The instructions in this attachment use the following typographic conventions:

bold      Represents objects on the screen that you click with the mouse pointer, including buttons,
Internet links, icon, tabs, menu items (e.g., Cancel button, Auctions link, Save option in the
File menu).

italic    Represents field names or areas of a screen (e.g., Licensee Name field, Applicant Information
area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions.  For
example, if you are instructed to type http://www.fcc.gov, you should type all of the
characters shown in bold italic exactly as they are printed.

SMALL     Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).
CAPS

Note: Throughout these instructions, "enter" means to type the appropriate information and then press the
ENTER key.

Performing an Application Search

Once you have connected to the FCC Network, follow the procedures below to search for an application.
You may click the ? (Help) button at anytime for additional information on using Application Search.

1. Connect to the FCC Network using one of the following options:

Note: If your PC is connected to a network, you must use a secure proxy to access the FCC Network.
Consult your Network Administrator.

Dial-Up Access

a. Use Dial-Up Networking in Windows 95/98 to connect to the FCC Network  (see Attachment C).

http://www.fcc.gov/wtb/uls
http://home.netscape.com/download/archive.html
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b. Start your web browser. In the location field of the web browser screen, type
http://wtbwww05.fcc.gov. Then press the ENTER key.

Internet Access

a. Start your web browser and connect to the Internet using your Internet Service Provider.

b. In the location field of the web browser screen, type http:// www.fcc.gov/wtb/uls. Then press the
ENTER key.

2. Verify that Java and JavaScript are enabled in your web browser preferences. Additionally, the
preferences must specify "Accept all cookies." Refer to your web browser Help facility for more
information.

3. On the Universal Licensing System main page, click the Application Search button, located on the left
side of the page.

Note: Application Search utilizes "cookies". If you are receiving a notification message when accepting a
cookie, we recommend that you disable this message in your web browser options. Please consult you
web browser Help facility for more information.

4. Select the type of search by clicking the down arrow in the Select Search Type field to obtain a menu
containing the following options. Select General and click the Continue button.

5. The Application Search screen appears. This screen contains several data entry fields used for
specifying the criteria for your application search. Specify the search criteria necessary to locate the
desired application. Please refer to the following "Basic Guidelines for Specifying Search Criteria" for
more information.

If you are searching for an application filed for Auction 39, click 39 in the Auction ID field.

Basic Guidelines for Specifying Search Criteria:

•  You must specify search criteria in at least one field. You do not have to specify search criteria in all
of the search fields. Enter search criteria into as many fields as you wish.

•  To specify search criteria in a search field containing a menu of options, click the desired option from
the menu. Use the scroll bars to view all options in a menu. You can select multiple options from a
menu by pressing the CTRL key while you click the menu options.

•  Click <No Criteria> to undo a menu selection and search for all options in the menu.

•  Click the Clear button to reset entries in all of the search fields.

•  The Universal Licensing System restricts the number of rows returned in an application search to
3000.

Click the ? (Help) button for a definition of each search field available on the Application Search screen.

6. After you have specified the desired search criteria, click the Search button. The system will scan the
database for any applications matching the search criteria. The matching application files will be listed on
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the Search Results screen. The Search Results screen will identify the file number, licensee name,
application purpose, application status, radio service code, and receipt date for each application returned
in the query.

A message on the Search Results screen will indicate if no matches were found for the specified search
criteria. Click the New Search button and re- specify search criteria.

7. To view an application, click its file number link. To navigate through the data on the Application
screen, use the scroll bar or click the links at the top of the screen. Click the ? (Help) button for
information regarding specific functions available on this screen.

•  To re-access the Search Results screen, click the down arrow end of the Other Options field to obtain
the drop-down menu of options. Click Search Results from the Other Options menu and then click
the Go button.

•  To begin a new search, click the down arrow end of the Other Options field to obtain the drop-down
menu of options. Click New Search and then click the Go button.

Technical Support

For technical assistance in searching the ULS for applications, contact the FCC Technical Support
Hotline at (202) 414-1250 (voice) or (202) 414-1255 (TTY). The FCC Technical Support Hotline
generally is available Monday through Friday from 7 a.m. to 10 p.m. ET, and Saturday 8 a.m. to 7:00
p.m. ET, and Sunday 12:00 p.m. to 6 p.m ET. Closed all government holidays.. All calls to the FCC
Technical Support Hotline are recorded.
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Attachment C

Accessing the FCC Network Using Windows 95/98

This attachment describes how to use Windows 95/98 Dial-Up Networking to establish a direct
connection from your PC to the FCC Network and the Universal Licensing System (ULS) in order to file
or review the Form 601.  This involves configuring dial-up network access and then performing the direct
dial-up procedure. This point-to-point connection is not routed through the Internet.

Please note that a direct dial-up connection is not required to search for applications in ULS. You may
review Form 601 on the Internet by entering http://www.fcc.gov/wtb/uls  on your Netscape 4.75 Web
browser and clicking the Search Applications button.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including buttons,
Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, Save option in
the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses area
of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions.  For
example, if you are instructed to type http://wtbwww05.fcc.gov, you should type all of the
characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then press
the ENTER key.

Hardware and Software Requirements

To connect to the FCC Network using Windows 95/98 Dial-Up Networking requires at a minimum the
following hardware and software:

Hardware Requirements

• CPU: Pentium or above
• RAM:  32 MB (more recommended if you have multiple applications open)
• Monitor:  VGA or above
• Modem: 28.8 Kbps, Hayes-compatible or faster (recommend 56.6 Kbps)
• Mouse or other pointing device

http://www.fcc.gov/wtb/uls
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Software Requirements

• Netscape Communicator 4.75 is recommended.  However, you can also use Netscape Communicator
4.73, 4.72, 4.7, 4.51 or 4.61. (Note that Netscape Communicator 4.6 and Netscape Communicator
versions earlier than 4.51 are not compatible.)

To download Netscape Communicator 4.75 free of charge, access the Netscape download site at
http://home.netscape.com/download/archive.html .

• Microsoft Windows 95/98

Note:  If you are running Windows in a networked environment, check with your local network
administrator for any potential conflicts with the Windows 95/98 Dial-Up Networking.  This usually
includes any TCP/IP installed network protocol.

• Adobe Acrobat 3.0 Reader (or higher) is recommended as a plug-in to your browser.  This provides a
viewer for displaying files related to applications, such as attachments and exhibits. For best results,
install the plug-in after you have installed the desired web browser. This will allow the plug-in to be
fully integrated within the browser window.

To download Adobe Acrobat version 3.0 or higher, access the Acrobat download site at
http://www.fcc.gov/wtb/reader/

Configuring Dial-Up Networking

1. To start dial-up networking:

a. Click the Windows 95/98 Start button.
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it from your
Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New Connection icon.

The Make New Connection window appears.

3. In the field entitled Type a name for the computer you are dialing, type ULS at FCC.

4. In Windows 95, click the down arrow at the right of the Select a modem field and select your
modem from the menu of available modems.

In Windows 98, click the down arrow at the right of the Select a device field and select your
modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according to the
modem manufacturer installation procedures, which are usually described in your modem’s user
manual.

http://home.netscape.com/download/archive.html
http://www.fcc.gov/wtb/reader/
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5. Click the Configure button.  Click the Options tab at the top of the Properties window.

6. In the Connection control area of the Options tab, verify that neither option is selected.  If either
option is selected, click the check box at the left of the option to deselect it.  Then click the OK
button.

7. Click the Next button.

8. Type 800 in the Area Code field and 844-2784 in the Telephone Number field.  Verify that the
correct country is selected in the Country code field.  If necessary, click the down arrow at the
right of the Country code field and select the appropriate country from the menu of available
countries.

9. Click the Next button.

10. Click the Finish button.  An icon titled ULS at FCC appears in the Dial-Up Networking
window.

11. Verify that properties are configured correctly before attempting a dial-up session.  Position the
mouse pointer on the ULS at FCC icon and click the right mouse button to display a menu.
Select Properties from the menu.

12. Click the Server Types tab at the top of the Properties window.

13. In the Advanced Options area, verify that only Enable software compression is selected.

If it is not selected, click the check box at the left of the option to select it.  If either of the other
options is selected, click the check box to deselect it.

14. In the Allowed Network Protocols area, verify that only TCP/IP is selected.

If it is not selected, click the check box at the left of the option to select it.  If either of the other
options is selected, click the check box to deselect it.

15. Click the TCP/IP Settings button.  In the TCP/IP Settings window, confirm that the Server
assigned IP address option is selected.  Then, in the section beneath, select Specify name server
addresses.

16. Type 192.104.54.1 as the Primary DNS.

Make sure that these two options are checked:

•  Use IP header compression
•  Use default gateway or remote network

17. Click OK on the TCP/IP Settings window and the Server Type window.

18.     a. Click the Windows 95/98 Start button, then click the Settings option to display the Settings
menu.

b. Click Control Panel and then double-click the Network icon.
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c. In the Configuration tab of the Network window, select TCP/IP and click the Properties
button.  (If there are multiple TCP/IP protocols, select TCP/IP, then highlight Dial-Up
Adapter and click Properties.)

d. Click the DNS Configuration tab.

e. Select Enable DNS.  Type bidder in the Host box, type fcc.gov in the Domain box,  then type
192.104.54.1 in the DNS Server Search Order box and click the Add button.

f. Click OK on the TCP/IP Properties windows, then click OK on the Network window.

g. If you are prompted to restart your computer, click Yes to restart, then begin the Dial-Up
Procedure.

Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button.
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d.  In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking.

The Dial-Up Networking window appears.

2. Double-click the ULS at FCC icon in the Dial-Up Networking window.

3. Click the Connect button on the window.  Do not enter User name and Password.

The Connecting window appears, indicating the status of your connection as your modem dials into
the system.  This window must remain running during your dial-up session.  You may minimize the
window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section below.

3. Once the connection is established, open your Web browser.

4. In your browser’s location field, enter http://wtbwww05.fcc.gov

If nothing appears in your Web browser, see the Troubleshooting section below.

5. When you have finished, exit the Web browser, then click the Disconnect button on the Connecting
window to end your dial-up session.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

http://wtbwww05.fcc.gov/
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Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking for a dial tone.

3. Confirm that the correct modem driver is installed for your modem.

Modem dials but does not connect

1. Confirm that the number the modem is dialing is correct.

2. Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the location in the Web browser

1. Check the settings in your dial-up networking icon, particularly that the Primary DNS is
192.104.54.1 and that TCP/IP is the only selected protocol.

2. Confirm that your web browser is not using proxies; it should be set to “direct connection to the
Internet”.

3. If you do log into a TCP/IP LAN, confirm that your LAN network IP address is being released.

To do so, connect to the FCC Network using dial-up networking, then click the Start button in
Windows 95/98 and select Run.  Type winipcfg and press OK.  If your IP address does not begin
with “192.104.”, then your LAN IP address is not being released.  Click the Release All button, or
consult your LAN administrator.

Receive an Internal Server error in the Web browser

1. Confirm that the address entered in the location field is correct (http://wtbwww05.fcc.gov).

2. Confirm that Java and JavaScript are enabled in your Web browser, and confirm that Cookies is set
to Accept All.

Technical Support

For technical assistance with installing or using FCC software, contact the FCC Technical Support
Hotline at (202) 414-1250 (voice) or (202) 414-1255 (TTY). The FCC Technical Support Hotline
generally is available Monday through Friday from 7 a.m. to 10 p.m. ET, and Saturday 8 a.m. to 7:00
p.m. ET, and Sunday 12:00 p.m. to 6 p.m. ET. Closed all government holidays.  All calls to the FCC
Technical Support Hotline are
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